
Express Setup guides you through profile setup using the most commonly used options.    You will answer 
three simple questions:
What do you want to copy?
Where?
When?



Custom setup guides you through profile setup using all possible options.    You can set advanced 
properties such as files to include or exclude, and compression.    You will answer five questions
What do you want to copy?
Where?
When?
Which files?
How?



Type the full path of a directory or folder containing the files you want to copy.

Example of a folder name:
A folder on your computer may be named: c:\My Documents\Letters or a folder on another computer on 
the network may be named: \\DocServer\Shared\John’s Files.

Note
You can also use the browse button to select a folder from a list.



Click this to select a folder you want to copy, the folder can be on your computer or on the network.

Note
Alternatively, you can type the full path of a directory or folder in the space next to this button.



Check this to copy files from the removable drive only when the volume name / label of the disk in the 
drive matches the one in the next box.    If you leave this unchecked, files will be copied from any disk in 
the removable drive without checking its name.



Enter the volume name / label of the disk in the removable drive that you want to copy files from.



Select this option to copy all files in the source location.



Select this option to specify which files from the source location you want to copy.

Note
After selecting this option, you must specify include and/or exclude criteria for file selection.



Check this to copy files from all the sub directories or folders from the source location.



Displays criteria for selecting files to be included in the copy.

Note
Use the Exclude Files area to specify files to be excluded from the copy.



Displays criteria for excluding files from the copy.

Note
Use the Include Files area to specify files to be included.



Type selection criteria for file names to be included in the copy.    You can type a specific file name to be 
included or use “?” and “*” characters (without the quotation marks) as wild cards to indicate “any single 
character at that position” and “any sequence of characters at that position”.

Examples:
*.doc
Acct.*
Report??.txt



Type selection criteria for file names to be excluded from the copy.    You can type a specific file name to 
be excluded or use “?” and “*” characters (without the quotation marks) as wild cards to indicate “any 
single character at that position” and “any sequence of characters at that position”.

Examples:
*.doc
Acct.*
Report??.txt



Click this to enter selection criteria for files to be included in the copy.



Select an item in the Include Files list and click this to remove it    from the list.



Click this to enter selection criteria for files to be excluded from the copy.



Select an item in the Exclude Files list and click this to remove it from the list.



Type the full path of a directory or folder to which the files should be copied.

Example of a folder name:
A folder on your computer may be named: c:\Back up of my Documents or a folder on another 
computer on the network may be named: \\DocServer\Shared\Monthly archives.

Note
You can also use the browse button to select a folder from a list.



Click this to select a folder to which you want the files to be copied. The folder can be on your computer 
or on the network.
Note
Alternatively, you can type the full path of a directory or folder in the space next to this button.



Check this to copy files to the removable drive only when the volume name / label of the disk in the drive 
matches the one in the next box.    If you leave this unchecked, files will be copied to any disk in the 
removable drive without checking its name.



Enter the volume name / label of the disk in the removable drive that you want to copy files to.



Select how often the files should be copied.

Note
Select Manual control if you do not want Second Copy to copy    the files automatically.    Once setup, 
you can select the profile from then main window and click on the Copy Now button to copy the files, 
when needed.

Select Once a day at to automatically copy files once a day at a specific time.    Enter the time of day in 
either 12 hour or 24 hour format. Examples: 12:00PM, 02:35PM, 18:00

Select Also run at Startup or Shutdown to run the profile when profile Second Copy starts or ends.    This 
will allow you to run the profile at those times in addition to the selected periods.



Indicates how to copy files between source and destination.



Select this option to copy files from source to destination. New or changed files in source will be copied to 
the destination but if you delete files from source they will not be deleted from destination.



Select this option to copy files from source to destination and automatically delete files from destination 
that are not in the source.    If you delete any files from the source, they will be deleted from the 
destination, next time Second Copy runs. 



Select this option to move files from source to destination. The source files will be deleted after they are 
copied to the destination.



Select this option to compress the copied files.    The compressed files are kept in PKZIP 2.04g 
compatible format.



Enter a password here to protect the compressed files from prying eyes.    You will need to use the same 
password to extract the compressed files.    If you forget the password, it can not be recovered.



Select this option to keep the source and destination in perfect synchronization.    When you add or 
change files in the source, they will be copied over to the destination.    If you add or change files in the 
destination, they will be copied over to the source.



Click this to return to the previous step.



Click this to proceed to the next step.



Click this to cancel any changes you may have made and return to the main window.



Click this to update the profile.



Check appropriate options to include system, hidden or read only files.    In most circumstances, there will 
be no need to uncheck these options.



Check this to keep source files in a sub folder of destination maintaining the source path.



Indicates how many older versions of files will be kept in the archive folder



Type the full path of a directory or folder in which you want the deleted files to be archived.

Before overwriting any file in either the source or the destination folder, Second Copy will move the older 
version to the archive folder.

Example of a folder name:
A folder on your computer may be named: c:\Deleted Documents or a folder on another computer on the 
network may be named: \\BackUpServer\Archived Files.

Note
You can also use the browse button to select a folder from a list.



Click this to select a folder in which you want the deleted files to be archived. The folder can be on your 
computer or on the network.
Note
Alternatively, you can type the full path of a directory or folder in the space next to this button.



Check this to archive files to the removable drive only when the volume name / label of the disk in the 
drive matches the one in the next box.    If you leave this unchecked, files will be archived to any disk in 
the removable drive without checking its name.



Enter the volume name / label of the disk in the removable drive that you want to archive files to.



Enter the maximum log file size here.    The log file will be recycled when it exceeds this size.



Check this to log only error messages.

Uncheck it to log all file and folder copy messages in addition to the errors.



Specifies the processing priority given to the background copy process.



Check this to show progress bar on the main window when files are being copied.



Select when you want Second Copy 97 to start.



Check this option to see a message box when Second Copy encounters a file that can not be copied 
because it is locked by another program.    You will see a message box for a specified length of time.    
This will give you a chance to close the file from the other application.



Check this option to let Second Copy try to copy a file that is in-use by another program using advanced 
locking techniques.    If the program that is currently using the file can not handle this kind of locking 
mechanism, it may generate errors.    Use this option with caution.



Select the length of time a message box should be displayed when a file is in use and locked by another 
application.



Check this to hear audible prompts for certain events.



Check this to move deleted files to recycle bin.    If checked, whenever Second Copy deletes or overwrites 
files it will move the old files to the Windows recycle bin.



Check this to use destination folder for temporary files created during compression.

When compressing to a Zip file, Second Copy creates a temporary file to hold changes.    It is most 
efficient to use the destination folder for this temporary file.    Uncheck this option if you are running out of 
disk space on the destination drive, such as a removable drive.    If unchecked, Second Copy will use the 
Windows Temp directory for the temporary file instead.



If this is checked, Second Copy will always scan the destination folder during copy, to ensure that all files 
are intact.    This allows Second Copy to recopy any destination files that are missing.

If this in unchecked, Second Copy will scan the destination folder only when needed.    If the destination 
folder is on a removable drive or a network which may not be available all the time, you may uncheck this 
option.



Specifies how many minutes after Windows starts, Second Copy should wait before copying files.



Type the full path of a directory or folder to extract the files to.    You can also use the browse button to 
select a folder from a list.



Click this to select a folder you want to extract the files to.    Alternatively, you can type the full path of a 
directory or folder in the space next to this button.



Select All files to extract all selected files.    Select Only newer files to extract only those files that are 
newer than the ones in the extract folder.



Check this to overwrite files without prompting.



Check this to extract files to a path below the extract folder, using the source path.



Check this to copy NT file permissions and other security information when Second Copy copies files 
from an NTFS volume to an NTFS volume.



Check this to copy NT folder permissions and other security information when Second Copy copies 
folders from an NTFS volume to an NTFS volume. 



Overview

Second Copy 97 allows you to keep a "second copy" of all your important files at a different location.      
Set it up once and forget about it.    Second Copy 97 will copy your files at specified intervals in the 
background without manual intervention.

A state of the art user interface offers easy setup wizards and multiple graphical views of the information. 
Second Copy 97 is a full 32-bit version of the Second Copy program that has been in use world wide 
since 1992.

To use Second Copy 97, simply create profiles for files you want to copy to another directory, folder, drive 
or computer across the network.    Each profile defines a source location, a destination location and how 
often the files should be copied.

Select Express Setup for most commonly used options, or select Custom Setup to define special options 
e.g. files to include or exclude, compression, and synchronization.



Quick Start

For a quick demonstration:

1 Run Second Copy 97 program if it is not running already. 
2 Click on the Second Copy 97 icon in the Windows System tray on the tool bar. You will find it next to 

the clock on the toolbar as indicated by an arrow here: 

3 When you click the icon, the Second Copy 97 main window will open.
4 Start Windows Explorer and place it beside the Second Copy 97 window.
5 Select a folder icon for a folder you would like to copy and drag and drop it on the Second Copy 97 

window.    A good folder to start with will be your My Documents folder.
6 When you drop the folder on Second Copy 97 window, the Second Copy 97 Profile wizard will pop up 

with a page titled: Where?
7 Type C:\Backup in the Destination folder box and click the Next button. If you already have a folder 

named backup, you may want to use a different name.
Click here        to see next 8 steps



Quick Start - continued

8 If the folder doesn’t already exist, you will see a confirmation message asking if you want to create it.
9 Click the Yes button to create the folder.
10 You will see a page titled: When?
11 Select “Every half hour” and click the Next button.
12 Type “My first profile” as the profile name (without the quotation marks) and click the Finish button.
13 You now have your first profile.    This profile will copy all files from the source folder that you selected 

to a folder named C:\Backup and it will copy any new or changed files to this folder every half hour.    

To see it in action, Select “My first profile” in the main window and press the copy now button:     
14 You will see a progress bar indicating the progress of the copy.
15 Select Second Copy Help Topics from the Help menu to learn more. 



What’s New

· New User Interface
· New Copy Options
· New Scheduling Options
· New Version Archival
· Version History

New Secured Internet Ordering and Registration:
http://www.centered.com



New User Interface
• Windows 95 Graphical User Interface.
• Explorer style main window
• Large icon, small icon, list and detail views of the profiles
• Profile wizard
• Drag and drop files from Windows Explorer
• New Help system



New Copy Options
• Long File Names support
• File compression - allows you to compress copied files, saving disk storage space
• Password protection for compressed files
• Two-way directory synchronization - allows you to keep identical copies of files in two locations.    

When you change the files in one location, the other location gets the updates automatically
• Delete unused files from destination automatically
• Move files
• Include and Exclude file filters
• Support for removable drives
• NT File security
• Year 2000 compliance



New Scheduling Options
Preset intervals allow you to choose the copy frequency to suit your needs.

Periodically:
• Every N minutes
• Every half hour
• Every one hour
• Every two hours
• Every four hours
• Every eight hours
• Every twelve hours
• Every N days

Once a day
• At a specific time

Manual
• Manually start the copy process when needed

Also run at
• Startup
• Shutdown



New Version Archival

Now you can conveniently archive several versions of the files.



To Create A New Profile

1 Select New Profile from the File menu, or click        button on the tool bar.
2 The profile wizard will come up
3 Select Express setup to answer three simple questions:

• What do you want to copy?
• Where?
• When?

or
Select Custom setup to answer:

• What do you want to copy?
• Where?
• When?
• Which files?
• How?

4 Follow the wizard steps and finally type a name for the new profile.
 Related topics



To View Or Change Profile Properties

1 Click on the profile icon whose properties you want to view or change.

2 Select Properties from File menu, or click        button on the tool bar.
3 The profile wizard will guide you through the steps to view or change the properties.
4 To view or change the source folder, destination folder or the time to copy, select the Express 
setup option, to change other options select Custom setup option.
5 Follow the wizard steps and click on the Finish button when done.

 Related topics



To View Profiles In The Main Window

You can view profile in four different styles. Click on one of the view buttons on the tool bar to change the 
main window display.

Large Icons - Profiles are displayed as large icons going across.

Small Icons - Profiles are displayed as small icons going across.

List - Profiles are displayed in a list going down and then across.

Details - Profiles are displayed in a table with the date and time of last run and the date and time 
of the next scheduled run
Note
• You can find out what each button on the toolbar represents by moving the mouse over the button and 

holding it there.
• In Details view, you can click on the title bar to sort the items in the order of entries in that column.
• The next profile to run is indicated by        sign next to it.



To Rename A Profile

1 Click on the profile icon you want to rename.
2 Select Rename from the File menu or press the F2 key.
3 Type the new name and press the Enter key, or
4 Press the cancel key to restore the previous name.



To Duplicate A Profile

1 Click on the profile icon you want to duplicate.
2 Select Duplicate Profile from the Edit menu.
3 The profile wizard will create a copy of the selected profile for you. 
4 Type the new name and click Finish. 

Note
To can make changes to the duplicate profile before saving it,    click the Back button.

 Related topics



To Delete Profiles

1 Click on the profile icon you want to delete.
2 Select Delete from the File menu, or

click        button on the tool bar, or
press the delete key.
3 You will be asked to confirm that you want to delete this profile.
4 Select Yes to delete the profile or No to cancel.

Note
You can delete multiple profiles by drawing a selection box around a group of profiles before you select 
the Delete option.    To draw a selection box around a group of profiles, click the mouse at a corner of the 
group, then drag the mouse to form a box.



Express or Custom Setup

Select Express setup to answer three simple questions:
• What do you want to copy? 
• Where? 
• When? 

or
Select Custom setup to answer:
• What do you want to copy? 
• Where? 
• When? 
• Which files? 
• How? 



To Set What To Copy

Click the Browse button to select the folder containing the files you want to copy. You can also type the 
full path of the folder in the space next to this button.

Example
A folder on your computer may be called:
c:\My Documents\Letters
or a folder on another computer on the network may be called:
\\DocServer\Shared\John’s Files.
Notes
• If you are copying from a removable disk, you can specify a disk volume name / label to copy from. 

Make sure to check the “Only copy from volume named” box.
• To assign a new volume name to the disk in the removable drive, type the new name and click Next.

 Related topics



To Set Where To Copy

Click the Browse button to select the folder to which the files should be copied. You can also type the full 
path of the folder in the space next to this button.

Example
A folder on your computer may be called:
c:\Back up of my Documents
or a folder on another computer on the network may be called:
\\DocServer\Shared\Monthly archives.
Note
• If you are copying to a removable disk, you can specify a disk volume name / label to copy to. Make 

sure to check the “Only copy to volume named” box.
• To assign a new volume name to the disk in the removable drive, type the new name and click Next.

 Related topics



To Set When To Copy

If you want Second Copy to make copies at a regular interval, select one of the following:
• Every N minutes - enter number of minutes 
• Every half hour
• Every one hour
• Every two hours
• Every four hours
• Every eight hours
• Every twelve hours
• Every N days - enter number of days

If you want Second Copy to make copies at a specific time, select:
• Once a day at, and enter the time. 

In addition to the above, you can set Second Copy to copy files at:
• Startup
• Shutdown

If you do not want Second Copy to copy the files automatically, select:
• Manual Control

Note
You can change the copy frequency any time after setup by selecting the profile and clicking on the 
properties button.

 Related topics



To Set Which Files To Copy

Make sure that you select the Custom setup option on the first page of the profile wizard.

• Select “All files” to copy all files from the source folder.

• Select “Only selected files”    to include or exclude certain files. 

Second Copy searches for all files in the source folder.    Only those files that match the include criteria 
are copied, unless they are excluded by the exclude criteria.

If there is no exclude criteria, all files meeting the include criteria are copied.    If there is no include 
criteria, only files that do not meet the exclude criteria are copied. 

Examples

To include all Word documents:
1. Select “Only selected files”.
2. Enter “*.doc” without the quotation marks in “Include File Specifications”.
3. Click the Add button in the “Include file specifications” group.
4. Press Next.

To include only Quicken data files named acct1 :
1. Select “Only selected files”.
2. Enter “acct1.*” without the quotation marks in “Include File Specifications”.
3. Click the Add button in the “Include file specifications” group.
4. Press Next.

To exclude any backup and temporary files:
1. Select “Only selected files”.
2. Enter “*.bak” without the quotation marks in the “Exclude file specifications” group.
3. Click the Add button in the “Exclude file specifications” group.
4. Enter “*.tmp” without the quotation marks.
5. Click the Add button again.
6. Press Next.

Notes
• You can specify a particular file by name, such as: “Monthly costs.xls” to be included or excluded.
• You can include or exclude directories by entering a part of the directory path between slashes, 

such as: “\Data\Backup\” or “\Oldfiles\”.    You can not use wild cards in such specifications. You can 
not enter the drive letter or a colon either.

• Use ? to indicate any character at that position
• Use * to indicate any number of characters
• You can enter multiple specifications on the same line by separating them with a semicolon. e.g. *.doc; 

*.xls; *.txt
 Related topics



To Set How To Copy

Make sure that you select the Custom setup option on the first page of the profile wizard.    The Express 
setup defaults to Simple copy.

The first time Second Copy runs a profile, it copies files as specified.    In subsequent runs, it only copies 
files that are newer or updated since the last run.

Selecting copy method
• Select “Copy source to destination” (Simple Copy) to copy all files from the source folder to the 

destination folder but not backwards.
• Select “Copy source to destination, delete obsolete files from destination” (Exact Copy) if you 

want the destination copy to match the source with no extra files.    If you delete files from the source, 
they will be deleted from the destination, the next time Second Copy runs.

• Check “Move source to destination” if you want to copy files from the source to the destination and 
then delete the source files. 

• Check “Compress source into a ZIP file” to save disk space on the destination drive.    The files are 
compressed in PKZIP 2.04g compatible format and can be uncompressed by PKUNZIP or WinZip 
programs. Enter a password to protect the compressed file.    You will need this password to extract the 
files. 

Caution
If you forget the password it can not be recovered.

• Check “Compress source into a ZIP file, delete obsolete files from ZIP” to compress files as 
above, but if you delete files from the source, they will be removed from the ZIP. 

• Select “Synchronize Source and Destination to match exactly”    to copy files both ways. 
Synchronization is useful for managing files in two remote sites.    It allows you to add or edit files in 
either the source or the destination folders.

Cautions
• If you want to delete files from both the source and the destination folder permanently, make 

sure to delete them manually from both folders.    Otherwise, Second Copy will copy the files 
back from the other folder, since it can not detect your intention to remove the files permanently.

• If you change a file from the source and it’s mirror image file from the destination before Second 
Copy has a chance to synchronize them, only the latest file will be kept and the older of the two 
files will be moved to the archive folder.

• Do not use the synchronization option without specifying an archive folder, unless you are sure 
that the same files will not be modified in both locations at the same time and you only want to 
keep the latest file.

Keeping old versions of files
• When you use Simple Copy, Exact Copy, Move or Synchronize you can also choose to keep old 

versions of files in an archive directory.    You can set how many older versions of files you would like 
to keep. Whenever you update a source file, Second Copy will copy the file to the destination and it 
will move the file in the destination to the archive folder.

Older versions of files will be kept in the archive folder.    Older versions of file X.TXT will be    will be 
named X.TXT, (    2nd last version of) X.TXT, (    3rd last version of) X.TXT and so on.

This option is not available for compressed files.

Deciding where to store the files
• Check the “Append source path to destination and archive folders” option to keep the source files in a 

sub directory of the destination or archive folder while maintaining the original source path.      This is 
useful if you use the same destination folder to keep backups of files from different source folders.    
Checking this options allows you to know which files came from where. 



• In case of synchronization, the “Append source path…” option is only used to decide whether the 
source path will be appended to the archive path and not the destination path.

Example:
Source folder: c:\My documents\Letters
Destination folder: d:\User backups\John
• if “Append source path” is checked, the source files are copied to d:\User backups\John\My 

documents\letters
• otherwise, they are copied to d:\User backups\John.

 Related topics



Automatic Processing

Second Copy runs in the background and monitors the profiles that need to be copied.    At specified 
intervals, it wakes up and starts the copy process.    For profiles that are set to run periodically or once a 
day, no manual intervention is necessary.

When the copy is in progress, you will see an animated icon on system tool bar.    If you click on the icon, 
you will see the main window with a progress bar and status of the copy.



Manual Processing

To start the copy process for a profile set in manual mode:

1 Click on the profile icon you want to copy.
2 Select Copy Now from the File menu, or

click        button on the tool bar, or
Double click on the profile.

Note
You can force profiles that are set to run periodically, to run immediately by following the above 
procedure. 



Suspending Copy Process

To temporarily suspend the processing of profiles, select Suspend from the File menu, or click the right 
mouse button on the icon and select Suspend.

When suspended, Second Copy will not monitor the profiles scheduled to be processed.    The suspended 
state will be indicated by        sign next to the profile icons and a check mark on the menu item. 

To resume operation, select Suspend from the menu again.    If you do not remove the suspension, 
Second Copy will resume the operation next time you start Windows.



Checking For Errors

• Under normal circumstances, the Second Copy icon on your system tray looks like:

• If there are errors during the copy process, then the icon changes to:

• On subsequent runs if all the profiles copy successfully, the error icon is reset.
• A red E next to the profile icon on the main window indicates profiles with errors in the last run.
• To manually reset an Error flag, Select the profile(s) and click on the “Reset Error Flag” menu item 

from either the “Edit” menu or the right click pop-up menu.
• All errors are logged in the Activity Log.



To View Source Files

1 Click on the profile icon.
2 Select Source Files from the View menu or click the right mouse button on the profile and select 

Source Files.
3 The source folder will be opened in Window Explorer.



To View Destination Files

1 Click on the profile icon.
2 Select Destination Files from the View menu or click the right mouse button on the profile and select 

Destination Files.
3 The Destination folder will be opened in Windows Explorer, if the files are not compressed.    

Otherwise, Second Copy 97 Zip Viewer will be displayed with all the compressed files in that profile.



To View Archived Files

1 Click on the profile icon.
2 Select Archived Files from the View menu or click the right mouse button on the profile and select 

Archived Files.    This option will be grayed out if the files are not being archived.
3 The archive folder will be opened in Windows Explorer.



To Extract Compressed Files

Follow instructions in the To View Destination Files topic to bring up Second Copy 97 Zip Viewer.

1 Click the files you want to extract.

2 Use Select All Files option from Edit menu or click        button on the tool bar, to select all files.

3 Select Extract option from the File menu or click        button on the tool bar.
4 Select the folder where the extracted files should be kept.
5 Click OK.



To View The Log File

Second Copy keeps an activity log in the Log file named Log.rtf.    To view the log:
• select Log from the View    menu, or

• click on        button, or
• click the right mouse button on the Second Copy icon and select Log.

 Related topics



To Find Text In The Log File

While viewing the log file, enter the text you want to find and press the enter key or click on the Find 
button.

Notes
• You can search for the word “Error” to look for errors in the process. 
• The lines with errors are displayed in red. 

 Related topics



To Save The Log File

You can save the log file for later viewing or analysis.    To save the log file, open the log, click the Save 
button and enter a new file name.

 Related topics



To Print The Log File

Open the log file and click the print button.    The log will be printed to the currently selected default printer.
 Related topics



To Clear The Log File

To clear the log file, open the log and click the Clear button.      You don’t need to use this option, since 
Second Copy periodically recycles the log file to save disk space.

 Related topics



To Set General Options

Include file types.
By default, Second Copy 97 includes files with System, Hidden or Read Only attributes as candidates 
for inclusion in the copy process.    In most circumstances, you will not need to change these.    
However, if needed, you can uncheck the appropriate option and files with those attributes will be 
ignored. 

Activity Log
Second Copy recycles the log file when it grows beyond a certain size.    You can change this size limit 
by entering a number in the box labeled Maximum file size. The file size you enter is in Kilo Bytes.    If 
you set this number to zero, Second Copy will recycle the log file every time it starts.

Log only error messages
You can reduce the size of the Log by checking this option.    It allows you to log only error messages 
instead of all the copy messages.    It is recommended that you do not check this until you are familiar 
with the Second Copy operations and the Log.    After you have run Second Copy for a few days and 
are satisfied with its performance, you can check this option. 

 See other Options



To Set Performance Options

Background copy priority. 
Second Copy 97 performs copies as a background task.    By default this task is done with the 
minimum impact on the foreground applications you are running.    This makes the copy process less 
intrusive but also slower than normal.    Set the priority to a level between Low and High to suit your 
needs.

Copy Progress
Second Copy 97 displays the progress of a copy process when files are being copied.    This is 
displayed on the main window’s tool bar.    Most of the time, you will be running second copy as a 
minimized program and will not need to see the copy progress bar.    If you uncheck the Show progress 
option, the progress bar will not be displayed and the copy process will be faster.

 See other Options



To Set Startup Options

By default, Second Copy 97 restarts itself if you shutdown Windows while Second Copy is running.    This 
is the preferred mode of operation.    If you exit Second Copy 97, by right clicking on the icon and 
selecting the Exit option, it will not restart itself when you restart Windows.

Select “Every time Windows starts”, to let Second Copy 97 start itself when you start Windows, 
regardless of whether it was running at the time of Shutdown or not.

Select “Only when invoked from the Start menu” to only run Second Copy 97 when you need it.

When you choose one of these two options, you can also specify that Second Copy should wait for a few 
minutes before starting copies.    This is useful for situations where, you have several programs that start 
with Windows and slow system down.

 See other Options



To Set Copy Options

Second Copy can not copy files that are in use and locked by other applications.    Normally, Second Copy 
logs an error indicating that a file could not be copied.

If you want Second Copy to warn you when it comes across a locked file, check the “Show message 
box and retry one more” option.    You will see a message box in the lower right hand corner of the 
screen indicating the file that is locked.    Second Copy will wait for the specified number of seconds and 
try to copy the file again.    This will give you a chance to close the locked file in the original application.

If you check the “Try to copy file” option, Second Copy will try to copy a file that is currently in-use by 
another program using advanced locking techniques.    If the program that is currently using the file can 
not handle this kind of locking mechanism, it may generate errors.    Use this option with caution.

If you check the “Play Sounds” option, you will also hear a sound when a file is locked or a disk needs to 
be inserted.    You can customize these sounds from the Windows control panel.

If you check the “Move deleted files to Recycle Bin” option, Second Copy will recycle deleted, moved 
or overwritten files.

When compressing to a Zip file, Second Copy creates a temporary file in the destination folder.    This 
means that the destination folder must have enough disk space to hold the Zip file and the temporary file, 
which can grow as large as the Zip file itself. If you uncheck the “Use destination folder for temporary 
ZIP files” option, the temporary file will be created in the Windows Temp directory and copied to the 
destination folder on successful compression.

When the “Always check destination folder to ensure that all files are intact” option is checked, 
Second Copy scans the destination folder and recopies any files that a user may have deleted 
inadvertently.    If you are using a removable drive or a network connection from a laptop, when the 
destination folder may not be always accessible, then you can uncheck this option.    If unchecked, 
Second Copy will scan the destination folder, only when needed.

 See other Options



To Set Windows NT Options

If you are running on a Windows NT, you will see a tab called NT.

Copy file security information
If you check this option, Second Copy will copy NT file permissions and other security information 
when it copies files from an NTFS volume to an NTFS volume.

Copy folder security information
If you check this option, Second Copy will copy NT folder permissions and other security information 
when it copies folders from an NTFS volume to an NTFS volume. 

 See other Options



Command Line Options

You can run Second Copy with the following command line options.

/Help Shows this help window
/EnableAllMenus Enables all menus in Zip Viewer
/Exit Exits application, prompts user if busy
/ExitNow Exits application immediately
/ExitWhenIdle Exits application after copying
/InitialWait=n Waits n minutes before copying
/ShowAboutBox Shows About Box
/ShowLog Shows log
/ShowProfiles Shows main window
/Suspend Suspends profiles
/UnSuspend UnSuspends profiles
“ProfileName” Runs the profile “ProfileName”



Directory Macro Expansion

You can enter variable macros as part of the directory names in Source, Destination or Archive folders.    
Second Copy expands these to the corresponding values when it runs the profile.    There are two types of 
macros, Date Macros are enclosed in $ signs and Environment Macros are enclosed in % signs.

Date Macros
The following expand to their corresponding values on the day the profile is run.

$Date$ Date as YYYYMMDD
$Time$ Time as HHMM
$DayOfMonth$ Date as a 2 digit number
$DayOfWeek$ Day of week as a short name
$Month$ Month as a short name
$MonthOfYear$ Month as a 2 digit number
$Year$ Year as a 4 digit number

Example
On December 31st 1997, a folder name C:\Backup\$Date$ will expand to C:\Backup\19971231.

Date Macros
The following expand to their corresponding values based on the Windows environment variables.

%VAR% Value of the environment variable VAR

Example
On a Windows NT system on a network,    a folder name F:\UserFiles\%USERNAME% may expand to 
F:\UserFiles\Administrator.



To Import Profiles From Second Copy 4.0

1 Select “Import from Second Copy 4 Profiles…” from the File menu.
2 Select the SecCopy.INI file in the Open dialog
3 Click Open
4 The profiles from Second Copy 4.0 will be imported and converted into new profiles.
5 Select the newly created profiles and verify all the settings.

 Related topics



To Change Imported Profiles

Second Copy 4.0 allowed entry of multiple sources going to a single destination in one profile.    Second 
Copy 97 defines profiles as one source going to one destination.    This simplifies the setup and 
management of profiles for most users.

In Second Copy 4.0 you entered a copy frequency in minutes.    Second Copy 97 simplifies this task by 
offering fewer, more practical choices.    The import process will set the frequency of the imported profiles 
to the next increment.    You can adjust them after the profiles are created to suit your needs. Follow the 
instructions under the topic Viewing Or Changing Profile Properties.

 Related topics



To Disable A Profile

In Second Copy 4.0 the check mark on the main window was used to disable or enable profiles.    To 
achieve the same effect in Second Copy 97, set the profile to run in Manual mode.    Follow the 
instructions for Manual Processing to copy files in this profile.

 Related topics



To Run Multiple Profiles

1 Select the profiles you want to run. To select multiple profiles:
• draw a selection box around the profiles with the mouse, or
• click the first profile, hold the shift key down and click the last profile, or
• click the first profile, hold the ctrl key down and click other profiles to select.

2 Select Copy Now from the File menu or click        button on the tool bar. 
 Related topics



To Delete SECCOPY.LOG Files

Second Copy 4.0 creates a small file named SECCOPY. LOG in the destination directories to track when 
files in a particular profile were copied. Second Copy 97 uses a more sophisticated approach to 
determine which files were changed and which files need to be copied. SECCOPY.LOG files are no 
longer needed.    When you are satisfied with the functioning of Second Copy 97 and do not intend to use 
Second Copy 4.0, you can delete all the SECCOPY.LOG files.

1 Click the Start button on the Windows task bar.
2 Select “Files or Folders…” from the Find menu.
3 Enter SECCOPY.LOG in the “Named” box on the “Name & Location” tab.
4 Select “My Computer” in “Look in:” box.
5 Click the Find Now button.
6 Windows will search for all SECCOPY.LOG files and display them in a list.    This may take a few 

minutes.
7 Select “Select All” from the “Edit” menu.
8 Select “Delete” from the “File” menu.
9 If Windows asks you to confirm deletion, answer Yes.

 Related topics



What Is Synchronization vs. Copy

The copy process copies files from source to destination folders only.    If you add or change source files 
they will be copied to the destination.    Changes to the destination files will not be copied to the source.

The synchronization process makes all the files in the source and the destination folders and all their sub 
folders exactly identical. 

• If you have added new files to the source, Second Copy copies them to the destination. 
• If you have added new files to the destination, Second Copy copies them to the source. 
• If you have updated files in the source, Second Copy copies them to destination. 
• If you have updated files in the destination, Second Copy copies them to the source.
• If you have deleted files from the source, Second Copy copies them back from the destination. 
• If you have deleted files from the destination, Second Copy copies them back from the source. 
Notes
• You can recover deleted files from the archive folder if you have specified one. 
• If you updated the same file both in the source and the destination, only the latest file is kept, the old 

one is deleted or moved to the archive folder. 
• If you intent to delete a file from both source and destination, you should delete it manually from both 

locations. 



Use Copy

Use the copy process to backup your important files to an alternate location.    If you are using the copy 
process, do not change the files in the destination folders.
Note
Select the “Copy files from source to destination, delete obsolete files from destination” option to make 
the backup copy exactly match the source.    This will delete files from the destination that you have 
deleted from the source.



Use Synchronize

Use the synchronize process to keep copies of your documents at two sites.    Use this option with 
caution.    Avoid changing the same files at the same time at both locations. See the How To Copy topic 
for more information.



Will It Work On NT?

Second Copy 97 will work on NT 4.0 but not on any earlier versions.



To Exit Program

Under normal conditions, you should let Second Copy run all the time.    This will allow it to keep your files 
updated as desired.

If you want to exit Second Copy:
1. Click the right mouse button on the Second Copy 97 icon on the system tray toolbar. 
2. Select Exit from the pop-up menu. 



To Uninstall Program

To remove the program from your system:

Standard procedure:
1. Select “Add/Remove Programs” from Windows control panel. 
2. Select “Second Copy 97” 
3. Click “Add/Remove…” button.

Manual procedure:
1. Select “Options” from the “Edit” menu of Second Copy 97.
2. Click the “Startup” tab.
3. Select “Only when run from the Start menu”
4. Click OK.
5. Exit Second Copy 97 by right clicking on the icon in the system tray and selecting Exit.
6. Delete the folder “C:\Program Files\Second Copy 97” or the folder where you have installed Second 

Copy.
7. Remove the registry key “HKEY_CURRENT_USER\Software\Centered Systems\Second Copy 97”



Contact Information

World Wide Web:
http://www.centered.com

e-mail:
sales@centered.com
support@centered.com

Mailing address:
Centered Systems
7137 Oak Ridge Road
Falls Church, VA 22042-2561
USA
Note
Open the Second Copy About box by clicking the right mouse button on the icon and selecting the About 
option. Click on our home address to bring up your Web viewer to connect to our home page. Click on the 
e-mail address to bring up your e-mail program.



Registration and Ordering

All orders are subject to the Second Copy 97 License Agreement.

When you register the software, you will receive an e-mail message with the Registration Key.    When 
you receive this information, bring up the About box and click the “Enter Registration Key” button. Type 
the “Registered To” and the “Registration Key” exactly as you see in the e-mail.

Once the software is registered, the initial splash screen will not be displayed when the program starts.

Pricing
A single user license of Second Copy is $29.95.

See Centered Systems home page: http://www.centered.com for current pricing and volume discounts.

Ordering by credit card: 
You can place secured credit card orders via the World Wide Web from Centered Systems home page: 
http://www.centered.com.    Information about placing credit card orders over the telephone is also 
available on the home page.

For fax, phone or mail orders use the Order Form for Credit Card Orders.

Ordering by check or money order: 
To order by check or money order drawn in US dollars on US bank use the Order Form for Check or 
Money Orders.



Second Copy 97 Order Form for Check or Money Orders

* This form is for check or money orders only.
* Use “Order Form for Credit Card Orders” for other orders.
* The check must be drawn in US currency on US bank.
* Latest version of Second Copy is available for download on Centered Systems web page at 

http://www.centered.com

Print and mail this order form to:

Centered Systems
7137 Oak Ridge Road
Falls Church, VA 22042-2561
USA

--------------------------------------------------------

  Single User License

   ____ copies at $29.95 each =______

  Site License

         5 users at $  119.95 =______ (20% discount}

        25 users at $  539.95 =______ (28% discount)

        50 users at $  899.95 =______ (40% discount)

       100 users at $1,199.95 =______ (60% discount)

       250 users at $1,799.95 =______ (76% discount) 

                Total payment =______ 

Registration Information:

  Date:     __________________

  Name:     __________________________________ 

  Company:  __________________________________ (for a company order) 

  Address:  __________________________________

            __________________________________

            __________________________________

            __________________________________

  Day Phone:__________________ Eve:_____________________

  E-mail:  _____________________________________(* REQUIRED)

      * You will get a registration key by e-mail.

      * No software is shipped.

  How did you hear about Second Copy?

  ______________________________________________________ 



Second Copy 97 Order Form for Credit Card Orders

Print and mail or fax this order form to: Public (software) Library: (PsL)
Phone: 1-800-242-4PsL(4775) Ext. 10552 or 1-713-524-6394 Ext. 10552

(8:00am - 6:00pm CST Mon.-Fri.)
Fax: 1-713-524-6398
E-mail: 10552@pslweb.com
Address: PsL, P.O. Box 35705, Houston, TX 77235-5705 USA. 

--------------------------------------------------------
Item #10552
  Single User License
   ____ copies at $29.95 each =______
  Site License
         5 users at $  119.95 =______ (20% discount}
        25 users at $  539.95 =______ (28% discount)
        50 users at $  899.95 =______ (40% discount)
       100 users at $1,199.95 =______ (60% discount)
       250 users at $1,799.95 =______ (76% discount) 
                Total payment =______ 

Billing Information:

  Credit card:    [ ] MC [ ] Visa [ ] AMEX [ ] Discover

  Name on card:   _____________________________________ 

  Card Number:    ____________________________ Expires: ____ 

  Billing Address:_____________________________________ 

                  _____________________________________

                  _____________________________________ 

        Signature:_____________________________________

Registration Information:

  Name:     __________________________________ (if different than above) 

  Company:  __________________________________ (for a company order) 

  Address:  __________________________________ (if different than above) 

            __________________________________

            __________________________________

  Day Phone:__________________ Eve:_____________________

  E-mail:   _____________________________________(* REQUIRED)

              * You will get a registration key by e-mail. No software is shipped.

  How did you hear about Second Copy?

  ______________________________________________________ 
THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.    THE AUTHOR OF THIS 
PROGRAM CANNOT BE REACHED AT THESE NUMBERS. 

Any questions about the status of the shipment of the order, refunds, registration options, product details, technical support, 
volume discounts, dealer pricing, site licenses, non-credit card orders, etc, must be directed to sales@centered.com.    PsL 
they will notify us within one business day of your order and we will e-mail the registration key directly to you.



License Agreement

Second Copy 97, © Copyright 1996-1998 Centered Systems, All Rights Reserved..

You should carefully read the following terms and conditions before using this software.    Unless you have 
a different license agreement signed by Centered Systems, your use of this software indicates your 
acceptance of this license agreement and warranty.
For information on distributing the shareware evaluation version of Second Copy 97 see the section titled 
Shareware License.

Registered Version
One registered copy of Second Copy 97 may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used non-simultaneously by 
multiple people, but not both.
You may access the registered version of Second Copy 97 through a network, provided that you have 
obtained individual licenses for the software covering all workstations that will access the software 
through the network.    For instance, if 8 different workstations will access Second Copy 97 on the 
network, each workstation must have its own Second Copy 97 license, regardless of whether they use 
Second Copy 97 at different times or concurrently.

Governing Law
This agreement shall be governed by the laws of the State of Virginia, United States of America.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED. Because of the various hardware and software environments 
into which Second Copy 97 may be put, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE 
IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data 
before relying on it.    The user must assume the entire risk of using the program.    ANY LIABILITY OF 
THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF 
PURCHASE PRICE.



Shareware License

See the section titled License Agreement for the full license agreement.

Evaluation and Registration
This is not free software.    You are hereby licensed to use this software for evaluation purposes without 
charge for a period of 30 days.    If you use this software after the 30 day evaluation period a registration 
fee is required as described in the section Registration and Ordering.    When payment is received you will 
be sent a Registration Key, no software will be shipped.

Unregistered use of Second Copy 97 after the 30-day evaluation period is a violation of U.S. and 
international copyright laws.

Distribution
Provided that you verify that you are distributing the Shareware Version you are hereby licensed to make 
as many copies of the Shareware version of this software and documentation as you wish; give exact 
copies of the original Shareware version to anyone; and distribute the Shareware version of the software 
and documentation in its unmodified form via electronic means.    There is no charge for any of the above. 

You are specifically prohibited from charging, or requesting donations for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission.    Disk Vendors approved by the Association of Shareware 
Professionals are permitted to redistribute Second Copy 97, subject to the conditions in this license, 
without specific written permission.



Compression Error Messages

Second Copy 97 incorporates Xceed Zip compression software from Xceed Software Inc.    When    
compression errors occur, they are entered in the Log file.    Use the following descriptions to diagnose 
the problem.

XcdErrorNoZipFile
The compressed Zip file was not found in the destination folder.

XcdErrorZipStruct
The contents of the Zip file are corrupted, and cannot be accessed. It is sometimes possible to open the 
Zip file with the Zip Viewer to automatically repair it.    If not, delete the Zip file and rerun the profile.

This error also occurs if an attempt is made to open a Zip file that does not contain any files.

XcdErrorMemory
There is not enough memory available to successfully complete the current operation.

XcdErrorBadCall
Unacceptable include or exclude file specifications have been entered. This error typically occurs when 
wildcards are not used properly. Use * (an asterisk) to indicate any number of characters at that position 
and ? (a question mark) to indicate any single character at that position.

XcdErrorNothingToDo
No files matched the include file specifications.

XcdErrorDiskFull
There was not enough space on the storage device to hold the temporary file that is created during 
compression. This temporary file can be as big as the original Zip file plus the sum of the sizes of the files 
that are being added to it.

XcdErrorEOF
An unexpected end-of-file occurred while reading the Zip file. This error can occur when the Zip file is 
truncated, is missing information, or is corrupted. It is sometimes possible to open the Zip file with the Zip 
Viewer to automatically repair it.    If not, delete the Zip file and rerun the profile.

XcdErrorLibInUse
The DLLs required for compression (XCDZIP32.DLL, XCDUNZ32.DLL) are currently being used on the 
system. This may happen if another program is using these DLLs.

XcdErrorUserAbort
The current operation was aborted at the user’s request.    This error can occur if you click the    Copy 
button or exit Second Copy during compression.

XcdErrorTestFailed
The Test method has tested the archive and that one or more files in the archive have a bad CRC or have 
corrupted header fields.

XcdErrorZeroTested
The Test method has not ended up testing any files in the archive to be tested.

XcdErrorDLLNotFound
The DLLs required for compression (XCDZIP32.DLL, XCDUNZ32.DLL) could not be found on the system. 
These DLLs are installed with Second Copy.    If you have moved these files, try reinstalling Second Copy.

XcdErrorInternalLogic 
A logic error occurred in Xceed Zip. In rare cases, a file error or unacceptable settings may cause this 



error to occur instead of another more appropriate error. If this error occurs, verify that the Zip file and the 
files to process are accessible. If you still get this error, contact Centered Systems.

XcdErrorTempFile
The temporary file could not be properly created. Xceed Zip creates a temporary file during compression 
in the destination folder.    This may occur when an incorrect destination path is specified, or it can occur 
if, during the current operation, the temporary file could not be accessed.

XcdErrorRead
A File Read error has occurred on a file being used by Xceed Zip. This error will occur when zipping files 
and there is a problem reading the zip file, the temporary zip file or one of the files to zip.
Check the status of the device where your zip file and temporary file are located to make sure it is online 
and accessible. Also make sure the files you are zipping are accessible and aren’t open by other 
applications. If you are zipping database files, make sure your tables or database is closed.
 
XcdErrorWrite
A File Write error has occurred on the archive file or one of the files being processed. This error can occur 
if the device where files are being written to becomes full, cannot be accessed or is having physical write 
errors.

Make sure there is enough disk space available on the device for the current operation, and make sure it 
is online and accessible.
 
XcdErrorParentDir
A command that would end up removing the parent directory was detected and canceled by Xceed Zip.
 
XcdErrorNameRepeat
Two or more files with the same filename and path were about to be added to the Zip file.

XcdErrorLatest
The Xceed Zip could not update the date of the Zip file.

XcdErrorDOSError
A File I/O error has occurred on the Zip file or one of the files being processed. A File I/O error can occur if 
Xceed Zip cannot read, write, open or create a file. It may also occur if, for any reason, a file being read 
from or written to can no longer be accessed. 

XcdErrorMultidisk
An attempt was made to work with a Zip file that spans multiple disks, but Xceed Zip was not set in 
Multidisk mode.

XcdErrorMultidiskBadCall
An attempt was made to execute an operation that is illegal when MultidiskMode is set to True. This error 
will occur when you try to Add files to an already existing multidisk Zip file, when you try to Delete or Fix a 
multidisk Zip file, or when you use the UpdateZipDate method on a multidisk Zip file.

XcdErrorWrongDisk
The wrong disk was repeatedly inserted after a request for a specific. Three (3) attempts at inserting the 
correct disk are allowed by Xceed Zip when unzipping.

XcdErrorCantCreateDir
A directory could not be created. This error typically occurs when the Extract Directory property cannot be 
created, or when the complete path for a file to be extracted cannot be created.

Make sure your application has the appropriate file permissions to write on the destination storage device.



Version History

Version 5.21
Highlights

· New: Year 2000 compliance.
· New: Rewritable CDs are now treated like removable hard drives.
· New: Now shows main form on startup if "Start only when run from start menu" is selected.    Also 

shows a "Close and Exit" menu item under "File" menu.
· Changed: Updated to version 3.0 of the compression libraries from Xceed Software.

Version 5.20
Highlights

· New: Support for removable drives. You can now copy files to a specific volume name.
· New: If a file to be copied (not compressed) is in use and locked by another program, you can 

receive an alert message. 
· New: More copy intervals. You can now specify N minutes, N days and also set a profile to run at 

startup or shutdown.
· New: A new copy mode to "Compress source into a ZIP file, delete obsolete files from ZIP".
· New: Play sounds to prompt you to insert disk or when a file is locked.
· New: You can now specify include directories as \SubDir1\ like the exclude directory 

specifications.
· New: Command line options to run Second Copy in batch mode.
· New: Directory Macro Expansion, allows you to separate your folders by day, month, user name 

etc.
· New: You have more control over ZIP file extraction paths and overrides.
· Changed: The error icon now resets itself when all profiles run error free. You can also see an 

indication on the main window about which profiles had errors in the last run.
· Changed: The password on the Zip files is no longer converted to uppercase.

Version 5.10
Highlights

· New: You can now save up to 25 older versions of files in the archive folder.
· New: You can choose to not append the source path to the destination folder.
· New: The new Zip Viewer sports an Explorer style interface.
· New: You can now exclude entire sub directories from a profile.
· New: Compressed files can now contain extended character sets in the file names.    This is 

useful for the European customers.
· New: An error icon is displayed on the system tray when there are errors in the copy process.    

This icon is reset to the normal icon when you view and close the Log file.
· Changed: The *.* specification now copies files with extensions.
· Changed: Second Copy 97 now copies and deletes empty directories.

Main Window
· New: You can now sort the columns in Details view in ascending or descending order.    Just click 

on the column header once to sort by that column's order, click again on the same column header 
to change the sort order.    The sort order is indicated by a > or a < symbol in front of the column 
heading. 

· New: New menu option is added to the main menu and the pop-up menu to show archived files. 
· New: Now you can press the Ctrl-A keyboard shortcut to select all profiles.
· Changed: All screen settings are now retained across sessions.

Zip Viewer
· New: The Zip Viewer sports an Explorer style interface with Large Icons, Small Icons, List, and 

Details views.
· New: You can now sort the columns in Details view in ascending or descending order, like the 

Main Window.
· New: Column width settings are now retained across sessions.



· New: If you right click the mouse in the file list, a pop-up menu appears with context sensitive 
options.

· New: You can view the file properties in an Explorer style properties dialog box.
· New: Now you can press the Ctrl-A keyboard shortcut to select all items in the Zip file.
· New: Now you can press the Delete key to delete selected items from the Zip file.
· Changed: When you extract from compressed files, the extraction path defaults to the source 

folder.
· Changed: If all files in a Zip file are deleted, the Zip file itself is automatically deleted.

Options
· New: New startup option allows you to start Second Copy 97,

- every time Windows starts, (new default)
0 - next time Windows starts, if Second Copy 97 is running at shutdown, (old default) or 
1 - only when run from Start menu

· New: You can set an Initial Copy Delay to delay the copying of files for a few minutes after 
Windows starts.    This is useful if you have several items in your startup group and starting the 
copy process immediately bogs the system down.

· Changed: Directories marked as Read-Only, Hidden, or Systems used to be skipped during the 
copy process.    Now those directories are skipped only if the corresponding options are off in the 
General Options setting.

Log Viewer
· New: When you open the Log file, it is now automatically scrolled to the end so you can see the 

latest log entries.
· New: A new status bar shows a summary line,    for a quick check on number of errors.
· New: Window size and position are now retained across sessions.
· New: The Find Text is now retained across sessions.
· Changed: Files that are in use by other programs are skipped during compression, these files are 

now logged as Errors.
Profile Wizard

· New: You can now save up to 25 versions of older files in the archive folder when you copy, move 
or synchronize.    This option is not available for the compressed profiles.

· New: Second Copy 97, by default appends the source path to the destination folder.    This is 
done to allow you to keep backups of multiple source folders in the same destination folder and 
be able to restore them individually.    A new option now allows you to turn this feature off.

· New: You can exclude a directories by specifying one or more directory levels between slashes. 
e. g. “\data\june\”    or “\oldfiles\”.    These specifications do not accept    wild cards.

· New: A new drop down list box with bitmaps replaces the older option buttons for Copy Modes on 
the How page.

· Changed: The "Add..." buttons on "Which file" page has been changed to "Add" (without ellipses) 
to indicate that no other pop-up dialog box will come up after you click the button

· Changed: The compressed files to a Novell drive no longer pose a problem on the first run.




